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Capitolo 1: preparazione  
1.1    Attivazione del programma Detrazioni                                                                                                  

L’attivazione delle varie procedure fiscali può essere effettuata, oltre che attraverso l’utility Caf Manager, anche 

singolarmente all’interno di ogni programma. Per abilitare il software DET in tutte le sue funzioni (stampa, invio 

…), è necessario eseguire l’attivazione dello stesso mediante la funzione Attivazione  Attivazione 

automatica (Figura 1); inserire il proprio  Codice Centro 

(più  sportello se presente) e Password, attribuiti dal CAF 

centrale (Figura 2), quindi selezionare Avanti per 

eseguire il processo di attivazione. 

                                                                                               

      Figura 1.          Figura 2. 

Scarica e importa manualmente il codice d’attivazione 

In alternativa all’attivazione automatica, è prevista una funzione per scaricare ed importare manualmente il 

codice d’attivazione, attuabile mediante l’opzione Scarica file di attivazione:   

Figura 3. 

 

 

 

 

eseguire il login (codice centro, eventuale sportello e password) per ottenere l’accesso alla pagina web, quindi 

selezionare l’opzione Scarica Codice di Attivazione (Figura 3) e premere il tasto Prosegui per salvare il file 

contenente il codice d’attivazione. Infine, dalla directory di salvataggio, ripristinarlo mediante la funzione 

Attivazione  Importa File di attivazione (Fig. 1). 

N.b.  Il codice ha  validità giornaliera  per cui le operazioni di scarico ed importazione del file vanno eseguite nello 

stesso giorno.                                                                                                                                                                       

 

1.2     Importazione dati da anno precedente e da altri dichiarativi 

Il programma DET offre la possibilità di importare i dati anagrafici dagli applicativi DET 2011 (anche da file di 

backup), 730/2012, RED/2012 e UNICO/2012 (con i prossimi aggiornamenti) mediante due tipi di importazione, 

singola o multipla. 
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1 Importazione Singola: l’importazione singola permette di importare qualsiasi anagrafica presente in archivio 

per quanto riguarda i software DET 2011, 730/2012, RED/2012 e UNICO/2012 (con i prossimi aggiornamenti). 
 

 
 

Dalla voce “importa da” occorre selezionare il programma dal quale prelevare le anagrafiche DET, 730, RED o 

UNICO.  

Nella sezione Codice fiscale, mediante il tasto “F2” è possibile visualizzare l’intero elenco delle anagrafiche DET, 

730, RED o UNICO e scegliere quale prelevare (è possibile anche inserire direttamente il CF del dichiarante ed 

importarlo direttamente nella procedura).  

 

 

2 Importazione Multipla: con l’importazione multipla si possono importare una o più anagrafiche dai software 

DET, 730 e RED. Si ricorda che con la funzione importazione multipla è possibile importare solo le anagrafiche 

730 che hanno come sostituto di imposta l’INPS (Codice Sede 111 e 222), e le anagrafiche RED che hanno come 

ente pensionistico INPS. 

  

Attraverso i filtri di selezione occorre specificare le dichiarazioni di cui importare le anagrafiche: 

 

 

da questa maschera è possibile 

scegliere le dichiarazioni 

filtrandole per Codice fiscale, 

Cognome o Nome 

 

 

 

 

 

 

 

 

nella maschera successiva è 

possibile impostare una ricerca 

delle anagrafiche filtrandole per 

gruppi e sportelli eventualmente 

presenti nelle procedure DET, 

730 e RED. 
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in questa maschera vengono 

visualizzate le anagrafiche 

precedentemente filtrate che si 

andranno ad importare nel 

programma DET. 

 

 

 

 

 

 

 

Capitolo 2: Compilazione, invio e cancellazione 
2.1    Inserimento di una nuova dichiarazione  

 

 

 

            TASTI SELEZIONE QUADRI                          TOOLBAR 

 

Per procedere all’inserimento di una nuova dichiarazione, utilizzare il menù FILE → NUOVA DICHIARAZIONE 

oppure cliccare sul tasto presente sulla toolbar. Comparirà a video la finestra d’inserimento dati anagrafici. Il 

Codice fiscale va rilevato direttamente dalla comunicazione cartacea inviata dall’ente di riferimento al pensionato 

o dal tesserino rilasciato dall’Amministrazione finanziaria. 

IMPORTANTE – L’indicazione di un C.F. errato può pregiudicare il normale iter della dichiarazione 

stessa. 

 

Nota La funzione F2 risulta di particolare utilità in diversi campi/righi compilativi, al fine di ottenere la lista dei 

valori possibili da imputare in ciascuna situazione o attivare nuove utility. 

La presenza dell’help F2 viene segnalata da una diversa colorazione del campo (giallo). 

 

2.2    Selezione di una dichiarazione già esistente 

Per accedere ad una dichiarazione immessa e salvata precedentemente, selezionare dal menù FILE la voce APRI 

l’elenco dei dichiaranti, oppure cliccare il tasto corrispondente sulla toolbar.  

Sono presenti una serie di filtri di ricerca (cognome o codice fiscale dichiarante) per una ricerca  più rapida. Un 

ulteriore aiuto  è fornito dalle voci presenti in alto a sinistra (vedi Figura 4), attraverso le quali è possibile trovare 

una dichiarazione appartenente ad uno Sportello del centro di raccolta o ad un Gruppo attribuito alla stessa. 

Inoltre, è possibile selezionare attraverso i filtri le dichiarazioni gestite da un operatore, trasmesse, non 

trasmesse, da ritrasmettere, complete, validate ecc. ecc.. 

 

 

 



 

 

PAGINA 6 DETRAZIONI D’IMPOSTA  

 

Figura 4. 

 

Selezionato il nominativo del dichiarante occorre selezionare sulla destra anche il modello che si intende aprire. 

Dalla maschera Elenco dichiaranti è possibile filtrare le dichiarazioni da visualizzare in base all’appartenenza ad 

una specifica tipologia, è disponibile (in alto a destra) il corrispondente menù a tendina previsto al campo STATO 

INVIO. All’interno del menù STATO INVIO risultano presenti le scelte, “Acquisite dal Caf”, “Scartate dal Caf”, 

“Trasmesse all’Ente ed in attesa di ricevuta”, “Acquisite correttamente dall’Ente” e “Scartate dall’Ente”. 

La dichiarazione viene interessata da continui cambi di “stato”, che vengono di seguito descritti in dettaglio. 

Gli “stati” che una dichiarazione DET può assumere sono: 

Acquisite dal Caf: dichiarazione inviata ed acquisita dal centro elaborazione dati del Caf. 

Scartate dal Caf: dichiarazione inviata e scartata dal centro elaborazione dati del Caf, in quanto sono presenti 

anomalie che non permettono l’invio della stessa all’Ente interessato. 

Trasmesse all’Ente ed in attesa di ricevuta: dichiarazione inviata al centro elaborazione dati Inps, in attesa 

dell’esito di acquisizione dell’Ente. 

Acquisite correttamente dall’Ente: dichiarazione inviata ed acquisita dal centro elaborazione dati Inps. 

Scartate dall’Ente: dichiarazione inviata e scartata dal centro elaborazione dati Inps, in quanto sono presenti 

anomalie che non permettono l’acquisizione della stessa (es. Codice fiscale del dichiarante errato). 

Per tutti gli stati sopra elencati, è prevista la possibilità di rettificare dichiarazioni già trasmesse, ad eccezione 

della posizione denominata “Trasmessa all’Ente ed in attesa di ricevuta” per la quale eventuali modifiche saranno 

consentite esclusivamente dopo aver ricevuto l’esito (di acquisizione o di scarto) da parte dell’ente pensionistico 

di riferimento. 

 

Nota In ogni finestra di immissione dati, non è possibile cliccare su OK ed uscire se sono presenti 

errori di compilazione (evidenziati da sottolineatura rossa o blu). 
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2.3     Aspetto e inserimento dei dati nei quadri 

Le finestre dei quadri presentano in primo piano i campi per l’inserimento dei dati. 

E’ possibile passare da un campo all’altro premendo il tasto TABULAZIONE (quello con le doppie frecce orizzontali 

posto alla sinistra della tastiera), premendo il tasto INVIO o, infine, cliccando il tasto sinistro del mouse nel 

campo di inserimento opportuno. Per tornare nel campo precedente utilizzare il comando SHIFT + TABULAZIONE. 

Premendo il tasto OK si ottiene la conferma (salvataggio) dei dati inseriti che vengono controllati dalla procedura 

e riportati sull’anteprima grafica (sfondo) dell’interfaccia. 

Nota Premendo il tasto F2 una volta posizionati in un campo codice o descrizione, si ottiene la consultazione 

della lista descrizioni precaricate all’interno del programma con i relativi codici. Non sarà possibile operare 

alcuna modifica. 

Nota bene In ciascun pannello d’immissione, se premendo il tasto “OK” non è possibile uscire, significa che è 

stato commesso qualche errore di compilazione (evidenziato tramite una sottolineatura di colore rosso o blu). 

 

2.4     Rilevamento di errori durante la compilazione 

Durante l’inserimento dei dati, il programma effettua un controllo sulla loro correttezza formale. Se viene 

riscontrato un errore si avranno due modalità di segnalazione: 

1- sottolineatura di colore rosso: il campo contiene un errore formale o un dato obbligatorio non ancora inserito; 

2- sottolineatura di colore blu: il campo contiene un errore di carattere fiscale. 

Entrambi precludono la possibilità di confermare il quadro. 

Durante l’immissione dei dati viene visualizzato, in basso nella finestra, l’help relativo al campo selezionato, il 

numero totale e la motivazione degli errori. 

 

2.5     Salvataggio e registrazione dati di una dichiarazione 

Per memorizzare i dati della dichiarazione compilata, occorre selezionare dal menù FILE la voce SALVA, oppure 

l’icona corrispondente sulla toolbar (rappresentata graficamente da un floppy-disk). 

Tale procedimento renderà definitivi gli ultimi dati inseriti, la dichiarazione verrà aggiunta in archivio 

e sarà così disponibile per un successivo utilizzo. 

 

2.6     Validazione di una dichiarazione 

La validazione di una dichiarazione applica un ulteriore livello di protezione ai dati immessi e salvati, 

rendendone impossibile la modifica attraverso le normali metodologie di immissione. Dopo aver compilato i vari 

quadri senza segnalazione di errori o anomalie, l’operazione di salvataggio oltre a registrare nel database la 

dichiarazione, proporrà l’opzione di VALIDAZIONE (seguita dalla richiesta di invio della stessa). 
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Attraverso i “tasti visualizzazione modello” è possibile muoversi all’interno del modello ed è anche possibile 

ingrandire o ridurre l’immagine grafica del modello. 

 

2.7     Invio dichiarazioni 

Invio multiplo: la trasmissione contemporanea di più dichiarazioni (validate) avviene utilizzando il tasto Invia 

presente sulla Barra degli Strumenti o dalla voce Servizi – Invio dichiarazioni, presupposto è che non ci siano 

dichiarazioni aperte; per facilitare l’invio sono presenti una serie di Filtri di Selezione che agevolano la ricerca 

delle dichiarazioni all’interno dell’archivio. 

La procedura di invio richiede un collegamento ad internet; in questo momento viene inoltre segnalata 

l’eventuale presenza di nuovi aggiornamenti del programma non ancora eseguiti. Il sistema non consente la 

trasmissione di dichiarazioni identificate con le seguenti motivazioni: Data di sottoscrizione non valida, 

Dichiarazione identica alla precedente trasmessa, La dichiarazione risulta inviata all''Ente e in attesa di ricevuta. 

 

2.8    Creazione di copie di salvataggio 

L’utilità per la creazione di copie di salvataggio consente di ottenere una copia sia dell’archivio sia dei dati di 

configurazione del programma: in caso di accidentale cancellazione degli archivi, perdita di dati, formattazione 

dischi a causa di virus e in tutte le situazioni che comportino la distruzione o il danneggiamento degli archivi, tale 

copia potrà essere ripristinata per riportare lo stato del programma a quello del momento in cui si è provveduto 

al salvataggio.  

La procedura di creazione è accessibile dal menù File → Copie di salvataggio → Crea copia di backup…, 

assegnando un nome e un percorso per il salvataggio del file (di estensione .bkdet). 

Per il ripristino dei dati, utilizzare il menù File → Copie di salvataggio → Ripristina copia di backup… e 

selezionare il file precedentemente creato. 

Attenzione! L’operazione di ripristino sovrascrive i dati presenti nell’archivio cancellando 

le dichiarazioni eventualmente inserite posteriormente al momento di creazione del file di 

backup, a meno che il ripristino non venga eseguito tramite la funzione IMPORTA 

contenuta nel menù SERVIZI. Per un’ulteriore garanzia, ogni qualvolta  si accede al programma, 

quest’ultimo all’uscita, effettua automaticamente una copia di backup ripristinabile dal menù Help → Backup 

giornalieri. In qualsiasi momento sarà quindi possibile ripristinare l’archivio del giorno precedente, anche se non 

creato manualmente ( a meno che non sia stata disabilitata la funzione di backup automatici nel menù    

Modifica →  Configurazione → Backup). 

 

Nota Si consiglia di creare spesso copie di backup degli archivi (ad esempio dopo aver ultimato l’inserimento di 

una dichiarazione) e salvarle su un floppy disk da conservare con cura: l’operazione richiede pochi secondi e 

preserva l’integrità degli archivi in qualsiasi situazione di emergenza o pericolo. E’ opportuno assegnare al file che 

si crea un nome significativo, che rappresenti, ad esempio, la data di creazione dello stesso (es. 13032012 – a 

significare 13 marzo 2012) ed etichettare il floppy disk con chiarezza prima di riporlo in luogo sicuro. Si ricorda 

che una copia di backup creata precedentemente è compresa in una ulteriore copia prodotta in un secondo 

momento. Qualora si voglia conservare le copie di backup su disco rigido, scegliere un percorso di destinazione. 

 

2.9     Esportazione ed importazione  dichiarazioni 

Utilizzando la voce Esporta dal menù Servizi, è possibile realizzare ugualmente un file di backup (.bkdet). Le 

dichiarazioni da esportare possono essere scelte, tra tutte quelle caricate in archivio, in base ad una serie di filtri 

di selezione, dopo aver assegnato al file d’esportazione un nome ed un percorso di salvataggio. 
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La funzione Importa del menù Servizi serve per ripristinare le dichiarazioni provenienti dall’esportazione o copia 

di backup, con la possibilità di accodarle e non sovrascrivere quelle presenti in archivio (anche per la ricerca 

dei nominativi da importare è previsto l’utilizzo dei Filtri di selezione). 

Nota  

1 - Il file contenente le dichiarazioni da importare può essere ripristinato su altra procedura DET/2012 solo se 

questa risulta allineata alla stessa versione del software di sorgente (un apposito messaggio avvisa l’utente circa 

la necessità di aggiornamento del programma). 

2 - Le dichiarazioni esportate ed importate manterranno il loro stato di VALIDATE, STAMPATE, TRASMESSE, il 

codice dello SPORTELLO del centro di raccolta da cui provengono, il nome del GRUPPO in cui sono state 

eventualmente inserite e il nome dell’operatore che le ha validate. 

 

Nota bene. Le dichiarazioni provenienti da una procedura DET utilizzata e configurata da un altro centro di 

raccolta, importate o ripristinate come copie di backup, perderanno tutti i dati relativi al centro da cui derivano 

(CODICE CENTRO DI RACCOLTA ed eventuale CODICE SPORTELLO). 

 

2.10   Eliminazione di una dichiarazione 

Per poter eliminare una dichiarazione presente in archivio è necessario prima di tutto aprirla e, una volta 

visualizzata, premere il tasto Elimina sulla toolbar. L’eliminazione non è consentita per i modelli trasmessi. 

 

Nota. Le dichiarazioni eliminate non sono in alcun modo recuperabili a meno che non si disponga di una copia di 

backup creata quando l’archivio ancora le conteneva. 

 

2.11   Creazione di un gruppo di dichiarazioni                                                                                                

L’utente ha a disposizione la possibilità di creare dei gruppi di dichiarazioni selezionando dal menù Servizi la 

funzione Modifica Gruppi di appartenenza. Nella finestra che si aprirà a video (Figura 5), sarà possibile 

indicare, selezionando l’apposita voce, il nome di un Gruppo al quale attribuire una o più dichiarazioni.   
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Figura 5. 

 

 

Dopo aver inserito un nuovo Gruppo o averne richiamato uno tra quelli già caricati nel software (premere F2 per 

visualizzarne l’elenco), confermando l’operazione con OK, si potrà utilizzare la funzione “Filtri di selezione” per 

decidere quali delle dichiarazioni presenti in archivio  verranno inserite in quel gruppo. 

 

Capitolo 3: stampe ed utilità 
3.1    Filtri di selezione                                                                                                                                 

La finestra Filtri di selezione (utilità messa a disposizione per le stampe multiple delle dichiarazioni, nelle 

funzioni di import ed export di dichiarazioni, per la gestione dei raggruppamenti e per l’invio simultaneo di più 

dichiarazioni) permette di effettuare una ricerca approfondita tra le dichiarazioni presenti in archivio.  

La videata esemplificativa (Figura 7, relativa alla funzione di invio multiplo) propone numerosi parametri di 

selezione che riguardano essenzialmente lo stato delle dichiarazioni. Le opzioni di questo menù possono essere 

abilitate o disabilitate spuntando i relativi check-box, se, invece, si evita di selezionare una delle voci, il filtro ad 

essa riferito non viene applicato per la ricerca in archivio. 

 

Figura 7. 

 

 

3.2     Utilità  del programma 

Nella sezione Servizi → Utilità → il programma offre alcune utili funzioni: 

Compatta ripara database: questa utilità, selezionabile dalla voce Servizi – Utilità, è indispensabile per 

correggere eventuali errori e anomalie nel database. 
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Altre funzioni di utilità:  

Inserisci nota (post-it): con dichiarazione aperta dal menù Modifica, selezionando Visualizza/Inserisci 

Note, potremo inserire dei brevi messaggi pro memoria da rileggere quando necessario e che verranno 

automaticamente aperti al prossimo avvio dell’anagrafica. 

Monitor di Rete: sempre dalla voce Servizi, consente di visualizzare quali altri operatori stanno utilizzando le 

procedure fiscali Caf in rete locale e quali dichiarazioni sono attualmente in uso. Queste dichiarazioni non 

potranno essere aperte finché restano in uso da un altro operatore. Dal menù sarà anche possibile inviare 

messaggi agli altri utenti semplicemente facendo un doppio click sul nome dell’operatore visualizzato in elenco. 

 

3.3     Stampe di utilità 

Dal menù Stampe, selezionando l’apposita voce Stampe di utilità, si accede all’utilità per la stampa delle liste 

che consentono all’utente di avere un quadro generale sulle dichiarazioni inserite. 

Liste: consentono di stampare degli elenchi di dichiarazioni e di dati caricati in archivio, utilizzando una serie di 

parametri di ricerca preimpostati selezionabili dalla voce Selezione filtro. 

 

 

 

3.4     Stampe 

 

Come descritto dalla figura di cui sopra esistono diversi tipi di stampe utilizzabili dell’utente. 

La prima distinzione da fare è quella tra stampe singole e stampe multiple: 

• STAMPE SINGOLE: questo tipo di stampa può essere lanciato solo quando si ha la dichiarazione aperta 

cliccando sull’apposita icona (quella raffigurante una stampante) nella toolbar. 

• STAMPE MULTIPLE: questo tipo di stampa, invece, può essere lanciato cliccando sull’icona di stampa 

presente nella toolbar avendo chiuso precedentemente le dichiarazioni. 

Una seconda distinzione è tra stampa PROVVISORIA e stampa DEFINITIVA del modello.  

• STAMPA PROVVISORIA:  disponibile insieme alla validazione della dichiarazione stessa. 

• STAMPA DEFINITIVA: disponibile solamente DOPO aver effettuato l’invio al C.A.F. della dichiarazione. 

Il tipo di stampa supportato dal programma è il seguente: 



 

 

PAGINA 12 DETRAZIONI D’IMPOSTA  

• PDF: questo tipo di stampa richiede come requisito l’installazione di Adobe Acrobat (Reader o Writer) 

versione 4.0 (consigliata) o successive. 

 

3.5    Stampa ricevuta consegna documenti 

 
 

Grazie a questa funzione sarà possibile rilasciare al contribuente una ricevuta con la quale si attesta l’avvenuta 

consegna della documentazione, in attesa dell’elaborazione e della trasmissione telematica della dichiarazione. 

 

Capitolo 4: configurazione 
4.1   Utilizzare il menù di configurazione 

 

 

Andremo ora ad analizzare nel dettaglio le varie voci che si possono visualizzare nel menù IMPOSTAZIONI 

accessibile dalla voce  MODIFICA  CONFIGURAZIONE. 

 

- AGGIORNAMENTI: Non rilevare gli aggiornamenti all’avvio del programma, spuntando questa voce il 

programma all’avvio non ricercherà eventuali aggiornamenti disponibili. 

 

- BACKUP: Disattiva la creazione delle copie di backup all’uscita, spuntando questa voce il programma non 

effettuerà più le copie di backup automatiche all’uscita dal programma e quindi non verranno create nella voce 

Help – backup giornalieri. 

 

- APERTURA: Non rilevare automaticamente la presenza di dichiarazioni da reinviare, spuntando questa 

voce, all’apertura il programma non darà più messaggi/avvisi sulla presenza di dichiarazioni da ritrasmettere; 

non mostrare in automatico i Gruppi e gli altri dati, selezionando questa voce all’apertura delle anagrafiche non 

verrà mostrata in automatico la maschera contenente i Gruppi e gli altri dati. 

 

- GESTIONE DICHIARAZIONI: In questa sezione è possibile visualizzare i tipi di dichiarazione gestibili 

dall’utente. 

 

Capitolo 5: novità operative 
 

Il presente capitolo è dedicato alla divulgazione delle novità introdotte dalla nuova convenzione stipulata dai CAF 

con l’ente pensionistico INPS, dall’art. 7, Legge  n. 106/2011 e dall’art. 21 D.L. 201/2011 convertito e modificato 

Da qui si 
abilitano/disabilitano 
le varie opzioni del 
programma. 
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dalla L. 214/2011. I cambiamenti più rilevanti riguardano la tempistica per la trasmissione telematica agli Enti 

delle pratiche raccolte localmente e le attività di controllo che gli Enti stessi effettueranno sulle dichiarazioni. 

 

 

5.1 Tempistica trasmissione telematica 

Al fine di favorire l’efficace assolvimento del compito a carico degli Enti, relativo all’acquisizione, al calcolo ed alla 

corresponsione delle detrazioni richieste dai pensionati, il CAF trasmette telematicamente le dichiarazioni entro i 

tempi stabiliti dai rispettivi Istituti.  Il software in fase di invio effettua quindi un controllo su tale data 

riconducendola ad un termine temporale massimo di 10 giorni dalla data di sottoscrizione della richiesta. 

 

5.2 Correzione/rettifica dichiarazioni trasmesse 

In considerazione dei ristretti tempi di gestione delle trasmissioni telematiche, eventuali modifiche e correzioni da 

apportare a dichiarazioni già inviate al server del CAF centrale dovranno essere gestite redigendo dei modelli di 

rettifica. Le dichiarazioni ordinarie risulteranno immodificabili e con il tentativo di riapertura verrà restituito il 

messaggio illustrato nell’immagine sottostante. 

 

 

 

La dichiarazione di rettifica corregge e sostituisce quella ordinaria già acquisita dal CAF centrale o dall’Ente 

pensionistico di riferimento. Attraverso la rettifica è possibile sanare qualsiasi errore commesso nella 

dichiarazione ordinaria ad eccezione del codice fiscale del dichiarante. A validazione effettuata sarà possibile 

effettuare la trasmissione avvalendosi degli appositi filtri di selezione previsti (vedi immagine sottostante). 

 

 



 

 

PAGINA 14 DETRAZIONI D’IMPOSTA  

 

Con il completamento delle operazioni di invio le dichiarazioni saranno storicizzate all’interno dell’elenco dei 

dichiaranti per Istituto, stato e tipologia abbinandole alla medesima anagrafica come esposto nella figura 

sottostante. 

 

 

 

5.3     Controlli sulle dichiarazioni 

La convenzione in essere prevede che gli Enti effettuino delle verifiche su un consistente campione di 

dichiarazioni. Gli elementi oggetto di controllo ed eventuale sanzione saranno: i codici fiscali del dichiarante e dei 

familiari, la qualità del dichiarante e degli altri soggetti contenuti nel modello, la corrispondenza tra quanto 

esposto sulla modulistica e quanto trasmesso telematicamente all’Ente. A tal proposito si ricorda l’obbligo di 

conservare localmente una copia della dichiarazione regolarmente datata e firmata dal pensionato da produrre in 

caso di richiesta. 

 

 
5.4     Legge 12 luglio 2011 n. 106 – art. 7 (detrazioni da lavoro dipendente e per 

familiari a carico) 

La norma in paragrafo ha eliminato per i contribuenti l’obbligo di presentazione annuale della dichiarazione per le 

detrazioni d’imposta.  L’adempimento dovrà quindi essere espletato in maniera tempestiva solamente nel caso in 

cui, rispetto ai precedenti periodi d’imposta, siano intervenute variazioni rilevanti ai fini della fruizione del 

beneficio fiscale. 

 

 

5.5  Art. 21 D.L. 201/2011 convertito e modificato dalla L. 214/2011 
(soppressione INPDAP) 

Attenzione! Si ricorda che il D.L. 201/2011, convertito, con modifiche, dalla L. 214/2011, ha disposto la 

soppressione dell'INPDAP e il trasferimento delle relative funzioni all'INPS, pertanto tutti i soggetti che nel 2011 

erano sostituiti INPDAP da quest'anno dovranno essere gestiti direttamente con istituto INPS.  

Poiché l’INPS non ha ancora fornito specifici chiarimenti sulla gestione di tali pratiche, si informa che il software 

potrebbe subire modifiche/integrazioni. 

 

 


